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1 Safety precautions 

The following describe the safety precautions so that this product is used in a safe manner. 
The EZED2 is designed with the assumption that the user has an understanding of basic operations such 
as starting up and exiting applications and how to use a mouse in Windows 2000, Windows XP, 
Windows Vista and Windows 7. Use the product only after carefully reading and fully understanding 
these instructions. 
Also read the “Safety precautions” section in the operating manual that came with the product you are 
combining with the EZED2. 
 

Warning  
Handling the product without observing the instructions that accompany a 
“Warning” symbol may result in serious injury or death. 

Caution 
Handling the product without observing the instructions that accompany a 
“Caution” symbol may result in injury or property damage. 

NoteNote
 

The items under this heading contain important handling instructions that the 
user should observe to ensure safe use of the product. 

 

Warning  

Connection 
• Turn off the power to both the PC and applicable product when connecting. Failure to follow this 

instruction may cause electric shock. 
 

Caution 

Connection 
• When grounding the positive terminal of the power supply, do not connect any equipment (PC, etc.) 

whose negative terminal is grounded. Doing so may cause the equipment and applicable product to 
short, damaging both. Use a teaching pendant EZT1 or programming console MPC10 for editing data. 

Disposal 
• Dispose the EZED2 as industrial waste. 
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2 Introduction 

Perform any installation, uninstallation, editing, and other operations for the data editing software 
EZED2 using an account with Administrator privileges. 

� Notation rules 
This manual has been described in accordance with the following notation. 
The screens shown in this manual are those displayed in Windows XP. 
 

[  ] Menus and submenus shown in/from the title bar, buttons, and other controls that 
can be clicked with the mouse, are enclosed in square brackets. 

“  ” Dialog box messages, etc., are enclosed in double quotations marks. 

 Enter  Keyboard keys are shown in a box. 
 

Note The screens provided in this operating manual are those displayed in an ESMC 
controller by controller mode. 

� Functions of EZED2 
The EZED2 is PC software for editing the data necessary for the operation of motorized actuators. 
Data can be edited in various PC screens, or data set in an applicable product can be checked from a PC. 
The key functions of the EZED2 are explained below. 

• Editing and saving the data 
Operation data and parameters can be created and edited. 
Data edited in the EZED2 can be written to an applicable product (download), or data stored in an 
applicable product can be read into the EZED2 (upload). 
You can save data files created in the EZED2 in either the EZED2’s dedicated file format (.ez2) or CSV 
format. 

• Monitor function 
ON/OFF statuses of I/O signals can be monitored. 
Waveform monitor can be shown in windows display. 

• Test function 
I/O test can be performed to monitor input signals and cause output signals to be output forcibly. 
You can also perform test operations using the EZED2. 

� Applicable product 
Refer to “13 List of controllers supported by EZED2” on p.58 for the products that can be used in 
combination with the EZED2. 
These products are referred to as an “applicable product” in this document. 

� Hazardous substances 
RoHS (Directive  2002/95/EC  27Jan.2003) compliant 
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� General specifications of cable 
Interface USB Specification 1.1 (Full Speed 12 Mbps) 

Connector shapes RS-485 (Mini DIN 8 Pin: male), USB (Type Mini B: female) 
USB Type A connection via included USB cable to connect to a PC 

Communication system Half duplex 
Communication speed 9600 bps 
Indicator The LED is lit (green) when recognized by PC and ready to use. 
Power supply 5.0 VDC (bus power) 
Current consumption 25 mA (100 mA max.) 
Dimension 25×58.6×16 mm (0.98×2.31×0.63 in.) [excluding cable section] 

Mass PC interface cable: App. 0.2 kg (7.1 oz) 
USB cable: App. 0.03 kg (1.06 oz) 

Operating environment 
Ambient temperature: 0 to +40 °C (+32 to +104 °F) (non-freezing) 
Ambient humidity: 85% or less (non-condensing) 
Atmosphere: No corrosive gas, dust, water or oil 

Insulation system Non-isolated 

� When using the EZED2 
Steps to set operation data and parameters using the EZED2 are shown below. 
 

Install device driver. (page 7) 
 

Install EZED2. (page 12) 
 

Connect your PC to an applicable product.∗ (page 19) 
 

Start EZED2. (page 20) 
 

Perform data communication between the PC and 
applicable product. (page 21) 

 

Edit data. (page 22) 
 

Download data files (page 36) 
 

Shut down EZED2. (page 21) 
 

∗ You can also connect the PC and applicable product after editing data. In this case, after saving the edited 
data to the PC, turn off both the PC power and applicable product power, connect the PC and applicable 
product, and then start them again. 

 

Note It is recommended to back up the application program to a suitable storage device or 
a medium since data loss is a possibility when using software. 
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3 Installation and uninstallation 

3.1 Required system configuration 
The installation of the EZED2 on a PC requires one of the following operating systems (OS) and a PC 
compatible with the OS you’ll be using. 

� Operating system (OS) 
You need an English version of any of the basic operating systems listed below. 
The following operating systems are compatible only with the 32-bit (x86) version. 
 

• Microsoft Windows 2000 Professional Service Pack 4 
Be sure to apply "Update Rollup 1 for Windows 2000 SP4" supplied by Microsoft Corporation. Check 
the "Add or Remove Programs" if the Rollup 1 is applied. 

 

• Microsoft Windows XP Home Edition Service Pack 3 
• Microsoft Windows XP Professional Service Pack 3 
• Microsoft Windows Vista Home Basic Service Pack 2 
• Microsoft Windows Vista Home Premium Service Pack 2 
• Microsoft Windows 7 Starter Service Pack 1 
• Microsoft Windows 7 Home Premium Service Pack 1 
• Microsoft Windows 7 Professional Service Pack 1 

� Personal computer 
CPU ∗1 Intel Core processor 2 GHz or more is recommended. 
Display resolution Video adapter or monitor of XGA (1024×768) or higher resolution 
Memory ∗1 1 GB or more is recommended. 
Hard disk capacity ∗2 Available disk space of 100 MB or more 
USB port USB1.1  1 port or more 
Disk drive CD-ROM drive (for installation) 

∗1 The hardware requirements for the OS must be satisfied. 
∗2 Microsoft .NET Framework 2.0 Service Pack 2 must be installed in your PC so that the EZED2 may 

function. Microsoft .NET Framework 2.0 Service Pack 2 will be installed automatically, if not already 
installed. Accordingly, a free hard disk space of up to 500 MB is required in addition to the hard disk 
capacity specified above. 

 

Note The required memory and hard disk capacities may be different, depending on the 
system environment. 

3.2 Before installing the EZED2 

� Terms for use of this software 
Read the terms specified below. Install the EZED2 only if you agree with all of these terms. 

1. All copyrights to or in the EZED2 belong to Oriental Motor Co., Ltd. 

2. Unauthorized use or reproduction of the EZED2 and its operating manual, whether in part or 
in whole, is prohibited. 

3. Oriental Motor is not liable for any incidental or indirect loss (data damage, business 
disruption, loss of business profit, etc.) arising from the use of or inability to use the EZED2. 

 

Note Administrator privilege is required for installation. 
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� If the EZED2 is already installed 
If the EZED2 is already installed, be sure to uninstall it by referring on p.17, and then install the EZED2 
again. 
 

Note If an overwrite installation is performed, the EZED2 may not operate properly. 

3.3 Installing the device driver 
 

Note • Administrator privilege is required for installation. 
• Do not connect the included USB cable to the PC when installing device drivers. 
• Always install the device driver prior to installing the EZED2. 

1. Insert the EZED2 CD-ROM into your CD-ROM drive. 

2. Open the “DRIVER” folder on the CD-ROM. 

   

3. Open the “CC05IF-USB” folder. 

   

4. Open the "WinXP_vista_7" folder. 
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5. Start Setup.exe. 
Installer is launched. 

   

In Windows Vista or Windows 7, right-click Setup.exe and then click [Run as administrator]. 

   

The following screen may be displayed in Windows Vista or Windows 7. Click [Yes] to proceed. 

   

Or 
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6. Click [Install]. 

   

7. The following screen may be displayed in some cases. Click [Continue Anyway] to proceed. 

   

The following screen may be displayed in Windows Vista or Windows 7. Click [Install this driver 
software anyway] to proceed. 

   

8. Click [OK]. 
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9. Plug the USB cable into the USB port on the PC. 
If the following screen is displayed, select “No, not this time” and click [Next]. 
In Windows Vista or Windows 7, it will proceed to Step 12 automatically. 

   

10. Click [Next]. 

   

Setup starts installing the device driver. 
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11. The following screen may be displayed in some cases. Click [Continue Anyway] to proceed. 

   

12. When the installation is complete, click [Finish]. 
The device driver has been successfully installed. 
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3.4 Installing the EZED2 
Note • Administrator privilege is required for installation. 

• Microsoft .NET Framework 2.0 Service Pack 2 must be installed in your PC in order 
to use the EZED2. Microsoft .NET Framework 2.0 Service Pack 2 will be 
automatically installed. 

• The system may be restarted after installing the EZED2. Be sure to close all other 
applications. 

1. Insert the EZED2 CD-ROM into your CD-ROM drive. 
A window pops up automatically, showing the folders on the CD-ROM. 

2. Open the “EZED2ENG” folder on the CD-ROM. 

   

3. Start Setup.exe (setup program). 

   

If Microsoft .NET Framework 2.0 Service Pack 2 is already installed in other operating system, it will 
proceed to Step 5. 
The following screen may be displayed in Windows Vista or Windows 7. Click [Yes] to proceed. 
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4. Click [Install]. 

   

Microsoft .NET Framework 2.0 Service Pack 2 will be installed. 

   

5. Click [Next]. 
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6. Read the terms of the agreement shown on the screen. If you agree with the terms, select “I 
accept the terms in the license agreement,” and then click [Next]. 

   

7. Enter the user name and organization, and click [Next]. 

   

8. Select “Complete” under Setup Type, and click [Next]. 
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9. Click [Install]. 

   

Setup starts installing the EZED2. 

   

10. When the installation is complete, click [Finish]. 
The EZED2 has been successfully installed. 
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3.5 Uninstalling the device driver 
Uninstall the device driver according to the following procedures. 

1. Disconnect the USB cable from the USB port on the PC. 

2. Click [Start] in the task bar, and then click [Control Panel]. 

3. In Control Panel, click “Add or Remove Programs”. 
Windows Vista: Click “Uninstall a program”. 
Windows 7: Click “Programs and Features”. 

4. Select “ORIENTAL MOTOR CC05IF-USB (Driver Removal)” in the list, and then click 
[Change/Remove]. 

   

Windows Vista or Windows 7: Click [Uninstall/Change] 

   

The "User Account Control" screen may be displayed in Windows Vista. Click [Continue] to proceed. 

5. Click [Uninstall]. 
The device driver is uninstalled. 
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6. Click [OK]. 
The device driver has been successfully uninstalled. 

 

7. A message to prompt to restart the PC may be displayed. Restart the PC. 
When the uninstallation is complete, the device driver is removed from the list. 

 

Note The uninstallation of the device driver will become effective by restarting the PC. 

3.6 Uninstalling the EZED2 
Uninstall the EZED2 according to the following procedures. 
 

Note Administrator privilege is required for uninstallation. 

1. Disconnect the USB cable from the USB port on the PC. 

2. Click [Start] in the task bar, and then click [Control Panel]. 

3. In Control Panel, click “Add or Remove Programs”. 
Windows Vista: Click “Uninstall a program”. 
Windows 7: Click “Programs and Features”. 

4. Select the “EZED2” in the list, and then click [Remove]. 

   

Windows Vista or Windows 7: Click [Uninstall] 
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5. Click [Yes]. 

   

The following screen may be displayed in Windows Vista or Windows 7. Click [Yes] to proceed. 

   

The EZED2 is uninstalled. 

   

When the uninstallation is complete, the EZED2 is removed from the list. 
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4 Connection, startup and shutdown 

This chapter explains how to connect your PC to a controller and start/shut down EZED2. 
 

Note Administrator privilege is required to use the EZED2. 

4.1 Connecting your PC to a controller 
Caution When grounding the positive terminal of the power supply, do not connect 

any equipment (PC, etc.) whose negative terminal is grounded. Doing so 
may cause the equipment and applicable product to short, damaging both. 

 

Note • Connect your PC to an applicable product using the accessory PC interface cable 
(sold separately) and USB cable. 

• The pendant connector (PENDANT/PC) on the controller is not insulated from the 
logic power supply input terminal. If the positive side of the logic power supply is 
grounded, do not connect the negative side to a grounded PC. Failure to do so, a 
shortcircuit will result. 

1. Turn off the PC and applicable product. 

2. Connect motor to applicable product. 

3. Confirm that the controller key is connected. 

  

Controller key

 

For the EZX Series, after connecting the linear slide to the applicable product, set the axis number 
setting switch on the applicable product. 

  

Axis number setting switch

 

4. Plug the accessory PC interface cable (sold separately) into the data edit connector on the 
applicable product. 
Plug the USB cable into the USB port on the PC. 
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5. Connect the PC interface cable and USB cable. 

  

PC interface cable

USB cable

PC

Data edit connector∗

Applicable

product

 

∗ The position of the data edit connector varies depending on the applicable product. 

6. Turn on the power to the PC and applicable product, and start the PC. 

4.2 Starting the EZED2 
Double-click the EZED2 icon on the desktop to start EZED2. 
Once EZED2 has started, the following window appears. 

 

 

Menu bar

Toolbar

Status bar
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4.3 Setting up the communication port 
If you have connected the PC and controller for the first time, set up the communication port. 

1. Click [Option...] from the [Communication] menu. 

 

2. Select the communication port to which the 
communication cable is connected, and click [OK].

 

4.4 Shutting down 
Click [Exit] from the [File] menu. 
EZED2 shuts down. 

 
 
 



5 Data edit 

−22− 

5 Data edit 

This chapter explains how to create data files, edit operation data and parameters, and store edited data. 

5.1 Creating new data 
1. Click the “New” icon in the toolbar. 

   

2. Select your product model from Product Series List and Product List, and click [OK]. 
The following window assumes that you are using a unit model: EZS3D030∗-K, controller model: 
ESMC-K2 in the controller mode. 
The figures indicated by ∗ will contain a desired letter (M, C1, C2, etc.). 

   

Setting items 
Items Contents 

Product Series List Select the product series name and controller model. 
“Ⅱ” in the series name is shown as “2.” 

Product List 
Select the unit model and controller model. 
(Controller) indicates that the controller is used in the controller mode. 
(Driver) indicates that the controller is used in the driver mode. 

Selection Log Up to five controllers you have connected most recently are shown. 
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The number indicating the stroke, shown on the Product List is a multiple of 50 mm (1.97 in.). 
When the stroke of your product is not shown, edit a number on the Product Name directly. 
Then, your product model is shown on the Product List. 

   

The data edit window appears. 
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5.2 Opening an existing data file 
1. Click the “Open” icon in the toolbar. 

   

2. Select the file you want to edit, and click [Open]. 

   
 

The data edit window appears. 
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5.3 Setting data in the data edit window 
You can set operation data and parameters in the data edit window. 

Data edit window (Example: Operation data) 

  

Setting items 
No. Items Contents 

Data Operation data Data required for positioning operation (travel, 
operating speed, etc.). 

I/O Parameters relating to controller I/O signals. 
Motor Motor parameters. 
Home Home operation parameters. 
Speed Speed parameters. 

Parameter

Common Parameters relating to controller environment or 
motorized actuator operation. 

Status Input/output status of I/O signals can be 
monitored. Monitor 

Waveform Waveforms can be monitored/measured. 
I/O Input/output status of I/O signals can be checked. 

1 Window selection 

Test 
Operation Test operation can be performed. 

2 Cell Enter data in cells. 
3 Setting items The name of each operation data or parameter is shown. 
4 Axis Select “ID=0.” 

5 Enable teaching 
operation 

The following functions can be enabled or disabled: 
Remote teaching, motor current ON/OFF switching, test operation, alarm monitor 

6 Actual position The current position of the motorized actuator moving part. 

7 Jog buttons In remote teaching, these buttons are used to move the motorized actuator 
moving part. 

8 Minimum Distance Set the minimum distance (resolution) of the motorized actuator travels in remote 
teaching. (This setting is effective only during test operation.) 

1

2

3

4 

5 
6

7 8
9

10
11 12

13 14 15

16 17

18
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No. Items Contents 
9 Set position data Clicking this button sets the position under “Actual position” as operation data. 

10 Motor current 
These buttons turn the motor current ON/OFF. 
OFF: The motor current is turned off. 
ON: The motor current is turned on. 

11 Operation Data # The operation data number used for operation 
12 Travel Travel corresponding to the selected operation data number. 
13 Preset position Clicking this button sets the current position as the preset position. 
14 Home operation Clicking this button performs home operation. 

15 Positioning 
operation Clicking this button performs positioning operation based on the selected data. 

16 Alarm condition The current alarm condition is shown. 

17 Clear the alarm Clicking this button resets the present alarms. (Note that some alarms cannot be 
reset.) 

18 Communication 
Status 

The EZED2/controller communication status is shown. 
This area remains blank if EZED2 is not communicating with a controller. 

� Data entry 
When the value in a cell is changed, the text in the applicable line changes to black. Resetting the cell 
back to the default value changes the text color to blue. 

• Entering a value directly 
Click a desired cell, enter a value using the keyboard, and then press the  ENT  key. 

  

• Selecting a value from a pull-down menu 
Double-clicking a desired cell displays a pull-down menu. Select a desired value from the pull-down 
menu. 

  

� Copying and pasting data 
You can copy an entered value and paste it into a different cell. Copying and pasting lets you quickly 
populate multiple cells with the same value. 

1. Select the data you want to copy, and then click the “Copy” icon in the toolbar. 
You can select a single value or multiple values. 
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2. Click the cell you want to paste the data into, and then click the “Paste” icon in the toolbar. 

   

5.4 Teaching 
You can physically move the motorized actuator’s moving part and set the achieved position as operation 
data. This operation is called “teaching.” Teaching is done in the remote teaching or direct teaching 
mode. 
 

Remote teaching Move the motorized actuator moving part using the buttons in the EZED2 
window. The achieved position is set as operation data. 

Direct teaching With the motor current turned off, move the motorized actuator moving part 
by hand. The achieved position is set as operation data. 

1. Select the axis number of the controller you want to use in teaching. 
Select “ID=0.” 

2. Select “Enable teaching operation” in the operation data setting window. 
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3. Click [OK]. 
Teaching operation is enabled. 

 

4. Click the cell containing the travel you want to change. 

   

5. Move the motorized actuator moving part. 

• Remote teaching 
Move the motorized actuator moving part using the jog buttons. 
Set the minimum travel under “Minimum Distance.” 

  

 Move the motorized actuator in the negative direction at the common operating speed. 
 Move the motorized actuator in the negative direction at the starting speed. 
 Move the motorized actuator in the negative direction by the minimum travel. 
 Move the motorized actuator in the positive direction by the minimum travel. 
 Move the motorized actuator in the positive direction at the starting speed. 
 Move the motorized actuator in the positive direction at the common operating speed. 

 

Note • The common operating speed and starting speed can be set using common 
parameters. If a common parameter has been changed, it must be downloaded to 
the controller. The new value does not become effective until it is downloaded to 
the controller. For details on download, refer to page 36. 

• Before performing remote teaching, always close all other programs. If other 
programs are still running, the motorized actuator may not operate correctly. 

• Direct teaching 
Click [OFF] under “Motor current.” 
When the message dialog box appears, click [OK]. This turns off the motor current. 
Now that the motor is free, move the motorized actuator moving part by hand. 

 

→ 

 
 

Note If the motorized actuator is installed in an orientation other than horizontal, do not turn 
off motor current regardless of whether the motorized actuator is operating or 
stopped. Turning off the motor current cuts off the holding torque of the motor, which 
may cause the load to drop. 
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6. With the motorized actuator moving part at a desired position, click [Set position data]. 
The current position is entered in the cell selected in step 4. 
When position data is changed via teaching, the positioning type of the applicable operation data will 
change to “ABS” automatically. 

   

 

   

 
 

7. To perform direct teaching, click [ON] under “Motor current” to turn on the motor current 
again. 

   
 

Note Teaching does not save operation data to the controller. Be sure to download the new 
operation data to the controller and write the data to the controller’s memory. 

5.5 Saving a data file 
After setting operation data and parameters, save them in a file. 
Data files can be saved in EZED2’s dedicated file format (.ez2) or CSV format (.csv). 

� Saving data by overwriting 
Click the “Save” icon in the toolbar. The current data is saved over the existing data. 

  

The setting changes to 
“ABS” automatically. 
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� Saving data under a different name 
1. Click [Save As...] from the [File] menu. 

   

2. Enter a new file name, and click [Save]. 
The data is saved under the specified name. 

   
 

Note To save data in the CSV format, select “CSV format (.csv)” under “Save as type.” 

� CSV format 
Data saved in the CSV format can be edited in applications other than EZED2. 
Note that once saved in the CSV format, files can no longer be opened or edited in EZED2. 
To edit a CSV file in EZED2, open the file in an application other than EZED2 and then paste the data to 
EZED2. 
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5.6 Restore default data 

� Restoring edited data 
You can initialize the data you have edited in the data edit window. 

1. Click [Initialize...] from the [Edit] menu. 

 

2. Select the data you want to initialize, and 
click [OK]. 

Setting items  
 Select all Operation data, all 

parameters 
 Operation data only Operation data. 
 Parameter only I/O, Motor, Home, Speed, 

Common 
    

3. Click [OK]. 
The data is initialized. 

 

4. When the restore to default is complete, click 
[OK]. 
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� Restoring default data in selected cells 
1. In the data edit window, select the cell you want to restore. 

   

2. Click the right mouse button, and click [Initialize...]. 
The value in the selected cell returns to the default. 

   

� Restoring default the controller 
You can restore data stored in a controller’s EEPROM. 

1. Click [Initialize...] from the [Communication] menu. 

   

2. Select “ID=0,” select the data you want to initialize, and then click [OK]. 

   

Setting items 
Select all Operation data, all parameters. 
Operation data only Operation data. 
Parameter only I/O, Motor, Home, Speed, Common 
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3. Click [OK]. 
The specified data in the controller’s EEPROM is restored. 

   

5.7 Ending data edit 
To close the data edit window, click [Close] from the [File] menu. 
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6 Data upload, download and verification 

This chapter explains how to write EZED2 data to a controller, read data from a controller into EZED2, 
and verify EZED2 data against controller data. 
 

Warning  
Turn off the power to the controller before connecting your PC to the 
controller. Failure to follow this instruction may cause electric shock. 

 

Note Data cannot be uploaded or downloaded from/to a controller whose device 
information is not stored. 
Device information consists of the following two items: 
· ID: Machine number setting used for communication with a PC or teaching pendant 
· Product name: Unit model name 
Controllers are shipped without device information. Therefore, save device 
information to your controller first. Next, check the controller’s device information in 
EZED2 and then save it in the data file. For details on how to check the device 
information stored in your controller, refer to”6.1 Checking device information.” 

6.1 Checking device information 
1. Click [Device Information...] from the [Tools] menu. 

   

2. Click [Update]. 
The connection status is checked. 
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3. When the check results are displayed, click [Close]. 

   

• When the controller’s ID and model name are not shown 
Check the following items: 
• Is the controller power on? 
• Does the controller support EZED2? 
• Are the PC interface cable connected properly? 

• When “Not supported” is shown under Product Name 
Check the following items: 
• Is the controller included in the list shown on page 58 ? 
• If the product name of the controller is correct, turn on the controller power with the motorized 

actuator connected to the controller, and then check the device information in EZED2 again. 
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6.2 Writing data to the controller 
You can write data created in EZED2 to a controller. 

1. Click the “Download” icon in the menu bar. 

   

2. Select “ID=0,” select the data to be download, and then click [OK]. 
The data is downloaded. 

   

Setting items 
Select all Operation data, all parameters. 
Operation data only Operation data. 
Parameter only I/O, Motor, Home, Speed, Common 

Verify download data After the download, the data stored in the controller is verified against the 
data shown in EZED2. 

 

3. After the data has been written, click [OK]. 
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6.3 Reading from the controller 
You can read data stored in a controller into EZED2. 

1. Click the “Upload” icon in the menu bar. 

   

2. Select “ID=0,” and then click [OK]. 
The data is read. 

   

3. After the data has been read, click [OK]. 
The data that has been read is displayed. 
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6.4 Verifying data 
You can confirm the data stored in a controller is the same as the data displayed in EZED2. 

1. Click [Verify...] from the [Communication] menu. 

   

2. Select the axis number of the controller you want to verify the data of, select the data to be 
verified, and then click [OK].  
Select “ID=0.” Data is read. 

   

Setting items 
Select all Operation data, all parameters. 
Operation data only Operation data. 
Parameter only I/O, Motor, Home, Speed, Common

3. When the verification is complete, click [OK]. 
When both data match: 

 
 

When the data do not match: 
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7 Positioning operation 

You can perform positioning operation from EZED2 using the data you have set. 
 

Note • Before performing positioning operation, be sure to confirm that the data displayed 
in the window matches the data stored in the controller. Positioning operation is 
performed using data stored in the controller. If the data in the controller is different 
from the data shown in the window, the motorized actuator may behave 
unexpectedly. 

• Before performing positioning operation, always close all other programs. If other 
programs are still running, the motorized actuator may not operate correctly. 

1. Download EZED2 data to the controller or upload data from the controller so that the data 
displayed in the window matches the data stored in the controller. 
For the download procedure, refer to page 36. 
For the upload procedure, refer to page 37. 

2. Select “Enable teaching operation” in the operation data setting window. 

   

3. Click [OK]. 
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4. Click [Home operation]. 
Home operation is performed. 

   

5. Click the operation data number you want to use for positioning operation. 
The selected operation data number is shown at the bottom of the window. 

   

 

   

6. Click [Positioning operation]. 
Positioning operation starts based on the selected operation data number. 
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8 Alarm check 

The alarm condition of the controller can be monitored in the operation data setting window. 
You can also reset the alarms that are currently present. 

1. Select “Enable teaching operation” in the operation data setting window. 
The alarm condition of the controller can be monitored. 

   

2. To reset the alarm, click [Clear the alarm]. 
The alarms are reset. 

   

Some alarms cannot be reset. For details, refer to the operating manual for the controller. 
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9 Monitor function 

I/O signals can be monitored in the data edit window. You can also check the motorized actuator speeds 
and I/O signal switching statuses in a waveform display. 

9.1 I/O monitor 
You can monitor the alarm condition and I/O statuses of the controller. 
 

Note The ON status of a signal indicates that the applicable photocoupler in the controller 
is carrying current, while the OFF status indicates that the photocoupler is not 
carrying current. 

1. In the data edit window, click [Monitor], and then click [Status]. 
The status monitor window appears. 

2. Select the axis number of the controller whose I/O signals you want to monitor.  
Select “ID=0.” 

3. Select “Start Monitor.” 

   

4. Click [OK]. 
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I/O signals are monitored. 

   

Setting items 
No. Items Contents 
1 Actual position Current position of the motorized actuator moving part. 
2 Select data # Selected operation data number. 
3 Alarm condition Present alarms. 

4 Clear the alarm Clicking this button resets the present alarms. (Some alarms 
cannot be reset.) 

5 Alarm History Up to 10 most recent alarms are shown. 

6 I/O status The ON/OFF statuses of respective I/O signals are shown. 
Each signal is shown in green if ON, and in white if OFF. 

5. To end I/O monitor, unselect “Start Monitor.” 

1 2

3 
4 5

6 



9 Monitor function 

−44− 

 

9.2 Waveform monitor 
The motorized actuator speeds and I/O signal switching statuses can be checked in a timing chart. 
You can also compare the command positions and current positions to perform fine-tuning. 
Four sets of waveforms (four channels) can be shown in the window simultaneously. 

1. In the data edit window, click [Monitor], and then click [Waveform]. 
The waveform monitor window appears. 

2. Select the axis number of the controller whose waveforms you want to monitor. 
Select “ID=0.” 

   

3. Set the required items for each channel. 

   

Setting items 
No. Items Contents 

1 ON Selecting this check box specifies that the applicable channel will be 
displayed. 

2 Measurement item Select the items you want to measure. 

3 POS 
Set the position in the window where you want to show the channel. 
Clicking the up arrow moves the channel position up, while clicking 
the down arrow moves the position down. 

4 Speed Set the speed indicated by one division along the vertical axis. 
(This item can be set only for CH1 and CH2.) 

1 2

3 4 



9 Monitor function 

−45− 

 

4. Set a trigger. 
Trigger is a function for automatically measuring waveform when the motorized actuator speed or I/O 
signal ON/OFF status satisfies a specific condition. 

   

Setting items 
Items Contents 

CH Select the channel you want to set a trigger for. 

LEVEL This item is shown when you have selected CH1 or CH2 under “CH.” 
Click the up/down arrows to set the trigger level of speed. 

EDGE 

Set the trigger detection condition. 
↑: For CH1 and CH2, this setting means that measurement will be triggered if 

the speed set under “LEVEL” is achieved while the motorized actuator is 
accelerating. 
For CH3 and CH4, measurement will be triggered when the I/O signal status 
changes from OFF to ON. 

↓: For CH1 and CH2, this setting means that measurement will be triggered if 
the speed set under “LEVEL” is achieved while the motorized actuator is 
decelerating. 
For CH3 and CH4, measurement will be triggered when the I/O signal status 
changes from ON to OFF. 

↑↓: This item sets both ↑ and ↓ as conditions. 

POSITION 
Set the trigger position in the screen. 
Clicking the left arrow moves the trigger position to left, while clicking the right arrow 
moves the position to right. 

MODE 

Select when to display waveforms. 
AUTO: Waveforms are constantly updated until waveform measurement is 

stopped. 
NORMAL: Waveforms are updated every time a trigger is detected. 
SINGLE: Waveforms are updated when a trigger is detected, after which 

waveform monitor will end automatically. 

5. Click [START]. 
Waveform measurement starts. 

   

Click [STOP] to stop the measurement. 
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� Measurement function 
You can measure the time delta and speed delta in the window based on measurement results. The time 
delta indicates the difference between T1 and T2, while the speed delta indicates the difference between 
V1 and V2.  
This function is useful if you want to check the time or signal interval over which the I/O has remained 
ON, speed difference between given two points, or the like. 

1. Under “MEASURE” on the right side of the window, select the channel you want to measure. 

 

2. To measure the time delta, select “∆T.” To measure the speed delta, select “∆V.” 
If ∆T has been selected, two vertical lines appear. If ∆V has been selected, two horizontal lines 
appear. 

   

3. Drag the vertical or horizontal lines with the mouse to desired measurement positions. 
The time delta or speed delta is shown below the graph. 

   

 
 

Time step/speed delta display

Time delta measurement
Speed delta measurement
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10 Test function 

You can perform I/O signal test and test operation in the data edit window. 

10.1 I/O test 
You can monitor input signals and cause output signals to forcibly output. This function is convenient if 
you want to check the wiring condition. 
 

Note • All functions and operations associated with I/O signals are disabled during I/O test. 
• The ON status of a signal indicates that the applicable photocoupler in the 

controller is carrying current, while the OFF status indicates that the photocoupler is 
not carrying current. 

1. In the data edit window, click [Test], and then click [I/O]. 
The I/O test window appears. 

2. Select the axis number of the controller you want to perform I/O test for. 
Select “ID=0.” 

3. Select “Start test.” 
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4. Click [OK]. 
You can now perform I/O test. 

   

You can monitor the ON/OFF statuses of the signals under “INPUT” and “SENSOR.” 
For the signals under “OUTPUT,” the ON/OFF status switches every time � is clicked. 
Each signal is shown in green if ON, and in white if OFF. 

 

Signal status Contact A (N.O.) I/O signal Contact B (N.C.) I/O signal 

ON (green) The photocoupler in the controller 
is carrying current. 

The photocoupler in the controller 
is not carrying current. 

OFF (white) The photocoupler in the controller 
is not carrying current. 

The photocoupler in the controller 
is carrying current. 

 N.O. : Normally open 
N.C. : Normally closed 

   

5. To end the I/O test, unselect “Start test.” 
The signals under “OUTPUT” (output signals) return to the statuses before the I/O test. 

Switch ON/OFF by clicking �. 



10 Test function 

−49− 

 

10.2 Test operation 
EZED2 can be used to check the operation of the motorized actuator before connecting the motorized 
actuator to a host controller. 
 

Note • Before performing test operation, be sure that the data displayed in the window 
matches the data stored in the controller. Test operation is performed using data 
stored in the controller. If the data in the controller is different from the data shown 
in the window, the motorized actuator may behave unexpectedly. 

• Before performing test operation, always close all other programs. If other 
programs are still running, the motorized actuator may not operate correctly. 

1. Download EZED2 data to the controller or upload data from the controller so that the data 
displayed in the window matches the data stored in the controller. 
For the download procedure, refer to page 36. 
For the upload procedure, refer to page 37. 

2. In the data edit window, click [Test], and then click [Operation]. 
The test operation window appears. 

3. Select the axis number of the controller you want to perform test operation for. 
Select “ID=0.” 

4. Select “Enable test operation.” 

   

5. Click [OK]. 
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You can now perform test operation. 

   

Setting items 
No. Items Contents 
1 Actual position Current position of the motorized actuator moving part. 
2 Alarm condition Present alarms. 

3 Clear the alarm Clicking this button resets the present alarms. (Some alarms 
cannot be reset.) 

4 Operation data # The operation data number used for operation. 
5 Travel Travel corresponding to the selected operation data number. 
6 Preset position Clicking this button sets the current position as the preset position. 
7 Home operation Clicking this button performs home operation. 

8 Positioning operation Clicking this button performs positioning operation based on the 
selected data. 

9 Jog buttons In remote teaching, these buttons are used to move the motorized 
actuator moving part. 

10 Minimum Distance 
Set the minimum distance (resolution) of the motorized actuator 
travels in remote teaching. 
(This setting is effective only during test operation.) 

11 Motor current 
These buttons turn the motor current ON/OFF. 
OFF: The motor current is turned off. 
ON: The motor current is turned on. 

6. To end the test operation, unselect “Enable test operation.” 
 
 

1 

2 

3

4 5
6 7 8

9 

10

11
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11 Other functions 

You can print EZED2 data or check the software version. 

11.1 Printing data 
You can print data and waveform measurement results. 
 

Note The print function is not available if you are using EZED2 with Windows® 98 or 
Windows® Me. 

1. Click [Print...] from the [File] menu. 

   

2. Set the items you want to print, print object, and color, and then click [OK]. 
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If all items under “Print Item” are selected, the data will be output over four A4 or letter size sheets. 

  

“Enable” and “Disable” in the printed operation data have the following meanings. They are not shown 
in the operation data setting window. 
 

Enable Operation data has been changed. The text in the corresponding cell is shown in 
black in the operation data setting window. 

Disable 
Operation data has not been changed. The text in the corresponding cell remains 
blue in the operation data setting window. (If a teaching pendant is connected, “No 
data” is shown.) 
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11.2 Checking version information 
You can check the version of EZED2 software you are using. 

1. Click [About EZED2...] from the [Help] menu. 

   

2. After you have checked the software version, click [Close]. 
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12 Troubleshooting and remedial actions 

If the motorized actuator does not operate normally, take appropriate actions by referring to the 
information provided in this chapter. If the problem persists after you have taken the necessary actions, 
contact our Technical Support Line. 

12.1 Error messages 
If EZED2 has encountered a problem while running, a corresponding error message is shown in the 
window. 
 

Message Cause Action 

It is in ‘Teaching is on.’ Teaching is currently enabled. Unselect “Enable teaching operation” in the 
operation data setting window to stop teaching. 

It is in ‘Status monitoring is 
on.’ 

Status monitor is currently 
enabled. 

Unselect “Start Monitor” in the status monitor 
window to stop status monitor. 

It is in ‘Waveform 
monitoring is on.’ 

Waveform monitor is currently 
enabled. 

Click [STOP] in the waveform monitor window to 
stop waveform measurement. 

It is in ‘I/O Test is on.’ I/O test is currently enabled. Unselect “Start test” in the I/O test window to 
stop I/O test. 

It is in ‘Test Operation is on.’ Test operation is currently 
enabled. 

Unselect “Enable test operation” in the test 
operation window to stop test operation. 

The model in the data file to be 
downloaded does not match the 
device information stored in the 
controller. 

Connect the controller whose device information 
matches the model set in the data file. For how 
to check the device information, refer page 34. The model did not match. 

The download is cancelled.
Device information is not stored 
in the connected controller. 

With the motorized actuator connected, 
reconnect the controller power and then perform 
download again. 

The model did not match. 
Do you want to open a new 
window and continue with 
the upload? 

The model in the data file to be 
uploaded does not match the 
device information stored in the 
controller. 

Connect the controller whose device information 
matches the model set in the data file. For how 
to check the device information, refer page 34. 

The connected controller is not 
supported. 

Check the catalog to see if your controller 
supports EZED2. If this error message appears 
on a controller model supporting EZED2, the 
EZED2 version may have to be updated. Please 
call our Technical Support Line or contact your 
nearest Oriental Motor branch or sales office. 

The product is not 
supported. The upload is 
cancelled. 

Device information is not stored 
in the connected controller. 

With the motorized actuator connected, 
reconnect the controller power and then perform 
upload again. 

The file type is not 
supported. 

The type of the data file 
specified after clicking [Open] 
from the [File] menu is not 
supported. 

Select a data file with an ∗.ez2 extension. If this 
error occurs with an ∗.ez2 data file, the data file 
may be corrupted. 

There is not enough disk 
space. 

The specified drive has not 
enough free space to save the 
data file. 

Select another drive or increase the free disk 
space in the drive. 

Insert a disk. No disk is inserted in the 
specified drive. Insert a disk. 

The file could not be saved. An error occurred in the 
destination drive. Select a different drive or format the disk. 
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Message Cause Action 

The file is corrupted. 
The data file specified by 
[Open] from the [File] menu is 
corrupted. 

The specified data file cannot be used. Create 
another data file. 

The file could not be read. An error occurred in the source 
drive. 

Perform read again. If the error occurs again, 
the problem may be with the PC. Take 
appropriate actions so that the PC operates 
normally. 

No printer is installed. No driver is installed for the 
specified printer. Install an appropriate driver for the printer. 

The data exceeds the 
setting range. 

The entered data exceeds the 
setting range. Enter data within the setting range. 

The data could not be 
pasted. 

The data to be pasted contains 
invalid values. 

• Paste valid data. 
• Select cells into which data can be pasted. 

The selected range to be 
pasted is invalid. 

Data could not be pasted 
because the copy range is 
different from the paste range. 

Check the source range, select an appropriate 
paste range, and then paste again. 

The teaching function could 
not be disabled. 

The teaching function could not 
be disabled due to a 
communication error. 

The teaching function could 
not be enabled. 

The teaching function could not 
be enabled due to a 
communication error. 

Check the connection with the controller. If the 
connection is normal, check for noise or another 
source of problem. 

Positioning operation could not 
be performed due to a 
communication error. 

Check the connection with the controller. If the 
connection is normal, check for noise or another 
source of problem. 

An alarm occurred. Remove the cause of alarm, and then reset the 
alarm. 

The default operation data is 
selected. Select operation data in which value are set. 

The positioning operation 
failed. 

• Too many operation data are 
linked. 

• Operation data of different 
directions are linked. 

In the link mode, up to five data can be linked. 
Operation data of different direction cannot be 
linked. 

The positioning operation 
could not be stopped. 

Positioning operation could not 
be stopped due to a 
communication error. 

The operation could not be 
stopped successfully. 

Operation could not be stopped 
due to a communication error. 

Check the connection with the controller. If the 
connection is normal, check for noise or another 
source of problem. 

Home operation could not be 
performed due to a 
communication error. 

Check the connection with the controller. If the 
connection is normal, check for noise or another 
source of problem. The return-to-home 

operation failed. 
An alarm occurred. Remove the cause of alarm, and then reset the 

alarm. 
The return-to-home 
operation could not be 
stopped. 

Home operation could not be 
stopped due to a 
communication error. 

Check the connection with the controller. If the 
connection is normal, check for noise or another 
source of problem. 

High-speed operation could not 
be performed due to a 
communication error. 

Check the connection with the controller. If the 
connection is normal, check for noise or another 
source of problem. The high-speed operation 

failed. 
An alarm occurred. Remove the cause of alarm, and then reset the 

alarm. 

The minimum-travel 
positioning operation failed.

Positioning operation by the 
minimum travel could not be 
performed due to a 
communication error. 

Check the connection with the controller. If the 
connection is normal, check for noise or another 
source of problem. 
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Message Cause Action 
Low-speed operation could not 
be performed due to a 
communication error. 

Check the connection with the controller. If the 
connection is normal, check for noise or another 
source of problem. The low-speed operation 

failed. 
An alarm occurred. Remove the cause of alarm, and then reset the 

alarm. 

The motor could not be 
excited. 

The motor current could not be 
turned on due to a 
communication error. 

The motor excitation could 
not be stopped. 

The motor current could not be 
turned off due to a 
communication error. 

The monitor function could 
not be disabled. 

The monitor function could not 
be disabled due to a 
communication error. 

The monitor function could 
not be enabled. 

The monitor function could not 
be enabled due to a 
communication error. 

The alarm could not be 
cleared. 

The alarm could not be reset 
due to a communication error. 

The alarm history could not 
be cleared. 

The alarm history could not be 
cleared due to a communication 
error. 

The alarm history could not 
be updated. 

The alarm history could not be 
updated due to a 
communication error. 

Check the connection with the controller. If the 
connection is normal, check for noise or another 
source of problem. 

The selected trigger 
channel is invalid. 

The selected trigger channel is 
not specified as a target of 
waveform display. 

Select a channel specified as a target of 
waveform display. 

The waveform 
measurement could not be 
started. 

Waveform measurement could 
not be started due to a 
communication error. 

The waveform 
measurement could not be 
stopped. 

Waveform measurement could 
not be stopped due to a 
communication error. 

The I/O test function could 
not be disabled. 

The I/O test function could not 
be disabled due to a 
communication error. 

The I/O test function could 
not be enabled. 

The I/O test function could not 
be enabled due to a 
communication error. 

The test could not be 
output. 

Output signals could not be 
output during I/O test due to a 
communication error. 

Check the connection with the controller. If the 
connection is normal, check for noise or another 
source of problem. 

The test operation function 
could not be disabled. 

The test operation function 
could not be disabled due to a 
communication error. 

The test operation function 
could not be enabled. 

The test operation function 
could not be enabled due to a 
communication error. 

The preset could not be 
stored. 

Presetting could not be 
performed due to a 
communication error. 

An error occurred during 
upload. 

A communication error occurred 
while the data file was being 
uploaded. 

Check the connection with the controller. If the 
connection is normal, check for noise or another 
source of problem. 
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Message Cause Action 

The upload failed. 

An out-of-range error or other 
error occurred while the data 
file read from the controller was 
being written to the data file in 
EZED2. 

Perform upload again. If the error occurs again, 
reinstall EZED2 and then upload the data file. If 
the error persists, the data file in the controller 
may be corrupted. 

No axis is selected. Communication was performed 
when no axis was selected. Select “ID=0.” 

The received data is invalid. The received data file contains 
an error. 

The received data could not 
be read. 

An error occurred while 
receiving the data file. 

The initialization failed. 
Initialization could not be 
performed due to a 
communication error. 

Connected-axis information 
could not be checked. 

Device information could not be 
checked due to a 
communication error. 

An error occurred during 
download. 

A communication error occurred 
during download. 

Check the connection with the controller. If the 
connection is normal, check for noise or another 
source of problem. 

The download failed. 
An out-of-range error or other 
error occurred while the data 
file was being downloaded. 

Perform download again. If the error occurs 
again, reinstall EZED2 and then download the 
data file. If the error persists, the nonvolatile 
memory of the controller may be corrupted. 

A communication timeout 
error occurred. 

The controller did not respond 
for a specified period or longer.

Check the connection with the controller. If the 
connection is normal, check for noise or another 
source of problem. 

The communication port 
could not be opened. 

The communication port was 
busy and could not be opened.

Check if the communication port is accessed by 
another application. 

The verification failed. An error occurred during 
verification. 

Perform verification again. If the error occurs 
again, reinstall EZED2 and then perform 
verification again. If the error persists, the data 
file in the controller may be corrupted. 

The port number exceeds 
the setting range. 

The communication port 
number read from the registry 
exceeds the setting range. 

Help cannot be found. The help file could not be 
found. 

An application error 
occurred. 

An error occurred while the 
application was running. 

The setting file is corrupted. The setting file could not be 
read. 

Reinstall EZED2. 
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13 List of controllers supported by EZED2 
 

Series Power supply specification Controller model 
24 VDC ESMC-K2 

100-115 VAC ESMC-A2 
EZSⅡSeries, SPFⅡSeries, SPV Series, 
SPRⅡSeries, ESR Series, EZCⅡSeries, 
EAS Series, PWAⅡSeries 200-230 VAC ESMC-C2 
EZX Series 100-115 VAC, 200-230 VAC EZXMC-W 
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